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Welcome to a new world of adventure. Your new StarShoot 
Solar System USB Eyepiece (SSUE) is capable of capturing 
detailed, full-color images of astronomical objects in our 
solar system. The planets, Moon, and Sun (with optional 
solar filter) can all be imaged to create spectacular views 
on your computer which can be saved for emailing or print-
ing later. The SSUE can even be used during the day to 
take images of terrestrial subjects. You’ll find that this inex-
pensive, yet capable and easy to use camera will enhance 
all of your journeys with your telescope.

Please read this instruction manual before attempting to 
use the camera or install the needed software.

Parts List 
StarShoot USB Eyepiece (SSUE)•	

CD-ROM •	

System Requirements (refer to Figure 1)

Telescope 
The SSUE can be used with virtually any telescope that is compatible with 
1.25" format eyepieces. The camera simply is inserted into a focuser in the 
same way as a standard eyepiece (Figure 1). If you use a star diagonal, you 
should remove it before installing the SSUE. If your telescope does not have 
enough inward focus travel, you will need to use an optional 1.25" Barlow lens 
to extend the telescope’s focal plane to the camera’s imaging plane (Barlow 
sold separately). 

For most types of astro-imaging with the SSUE, using a telescope with a 
focal length of at least 1000mm is recommended. Otherwise, the image scale 
may be too small. To increase the effective focal length of your system, use a 
Barlow lens or other type of tele-extender lens. 

Mount
While using an equatorial (EQ) mount is recommended to achieve the best 
results, one is not absolutely required for general imaging with the SSUE. 
Since the maximum exposure time is only a fraction of a second, astronomical 
objects will not drift significantly through a telescope attached to an altazimuth 

mount or Dobsonian base during single image captures. Use a sturdy mount 
that is appropriately sized for the telescope tube being used.

For obtaining the best planetary images, however, we do recommend an equa-
torial mount. Planetary imaging requires combining many individual images, 
and having an equatorial mount will prevent the planet from drifting out of the 
field of view of the camera during the time it takes to acquire the large number 
of images necessary. A motor drive (single-axis) is recommended too, so you 
can track the target object as you transmit live images to your laptop or PC. 

Computer
A computer is required for normal use of the SSUE. For astro-imaging in the 
field at night, a laptop computer is highly recommended. The camera driver 
and Orion Capture software requires Windows XP, Vista or 7.

The following hardware is required: 

Processor – Pentium III•	 ™ or equivalent, or higher 

Recommended minimum memory size is 256 MB. •	

Disk Space – 100 MB minimum, 500 MB or more recommended for •	
saving images.

Video Display – 800 X 600, 16-bit color or higher. 1024x768 or higher is •	
recommended. 

Mouse (external or built-in) •	

Internet connection required to display on-line help and downloading •	
image processing software

USB 1.0 or High Speed USB 2.0 port •	

Figure 1. To use the SSUE, a telescope, mount and computer are required.
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Software and Driver 
Installation 
Before the camera can be used, image 
capture software and a camera driver 
must be installed onto your computer. 
Turn on your computer and allow the 
Windows operating system to load as 
normal. Insert the included CD-ROM 
into your computer’s CD-ROM drive, and 
the Launcher will appear (Figure 2). This 
allows you to install the Orion StarShoot 
Solar System Imager camera driver and 
the Orion image capture software (Orion 
AmCap).

Camera Driver Installation

Do not connect the SSUE to your computer yet. 
Insert the CD-ROM into the drive. The 1.	 Launcher will appear. If you are 
using Windows Vista, the AutoPlay window will appear first. Select  
Run autorun.exe.

Click 2.	 Install Camera Driver. 

The 3.	 PC Camera Software Installation will start.. 

You are now ready to install. Click 4.	 Install. The installation will proceed. 

When installation is complete click the 5.	 Finish button.

Once the driver is installed, the computer will recognize the SSUE whenever 
it is plugged in. 

Capture Software Installation 
Now that the camera driver software is installed, the capture software must 
also be installed. 

Return to the 1.	 Launcher and click Install Capture Software. 

The 2.	 Orion AmCap Setup Wizard appears. Click Next. 

Select a destination folder and Click 3.	 Next.

Click 4.	 Next again to start the installation. 

When the wizard is complete, click 5.	 close. This has installed the capture 
software.

Plug in the camera into your computer’s USB port. 6.	

A 7.	 Found New Hardware notification will appear in your Windows task 
bar (Figure 3).

Wait a few moments and the cam-8.	
era will automatically install on your 
computer. When Device Installed 
Successfully notification appears 
you will be ready to use the cam-
era.

Open Orion AmCap from the icon 9.	
on your desktop. The Live Video 
Window should appear (Figure 4). 
The software will recognize many 
cameras so check that PC Camera 
is selected from the device menu. 

 
Image Processing 
Software
Website links are provided in the launch-
er to download popular free Image pro-
cessing software to be used with your 
AVI files to enhance your astro Images.

Image Processing Software such as 
RegiStax or AviStack; can Align and 
Stack(combine) hundreds of individual images into a single resultant image 
and perform some additional image processing to bring out subtle details or 
to make the image appear more pleasing overall. 

Both software applications are a recommended addition to any astro-imagers 
arsenal of image processing software.

Image Processing Software Installation 
Return the launcher and select RegiStax or AviStack to be directed to a web-
site to download the latest software.

For detailed information on the image processing software consult the web-
sites of each software Provider. Tutorials and user groups can be found online 
also. 

Getting Started During Daylight 
We recommend using the SSUE for the first time during the day. This way, you 
can become familiar with the camera and its functions without having to stum-
ble around in the dark. Set up your telescope and mount so the optical tube is 

Figure 2. The launcher provides an 
easy menu for software installation.

Figure 3. When initially connecting 
the SSUE to a computer, a Found New 
Hardware notification will appear and 
automatically install the camera to 
your computer.

Figure 4. The live video window.
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pointing at an object at least a couple of 
hundred feet away. Insert an eyepiece 
and focus as you normally would. 

To obtain first images with the SSUE, fol-
low these step-by-step instructions: 

Plug the camera into your com-1.	
puter’s USB port. 

Double click the Orion AmCap icon 2.	
now installed on your computer’s 
desktop. 

Orion AmCap will automatically 3.	
connect directly to your camera 
with a Live Video Window. Your 
Live Video Window will only show 
light and dark before the camera is 
coupled to your telescope. 

When the camera is connected 4.	
to the computer, the Live Video 
Window (and subsequent images 
captured with the camera) will dis-
play at 352x288 resolution. The 
native resolution of the camera sen-
sor is 320x240 and can be set from 
the options menu. Higher resolu-
tions are available but pixels will be 
interpolated from the native 320x240 
resolution and the larger image will 
not be as sharp as in 320x240 resolution. The higher resolution makes for 
better group live viewing and as a focusing aid. To change to full resolu-
tion mode, select Video Capture Pin from Options menu, select 1280x960 
under the Output Size heading, then click OK (Figure 5). The Live Video 
Window will now display at full resolution, and will occupy most of the 
computer monitor’s screen. Any images captured with the camera will now 
also be at full resolution. To move the Live Video Window out of the way, 
click on the top bar of the window and drag it to the desired location on 
the computer screen. 

To connect the camera to the telescope, simply replace the telescope’s 5.	
1.25" eyepiece with the camera. Make sure the securing thumbscrew on 
the focuser drawtube is tightened after the camera is inserted. 

You will now need to refocus the camera for the centered object. Focusing 6.	
will be the hardest thing to learn in the initial stages. If you are starting out 
in daylight, as is recommended, you may need to turn the exposure and/
or brightness control of the camera down before attempting to focus. This 

is done by selecting Video Capture Filter in the Options menu and moving 
the exposure or brightness slider (Figure 6). If the daytime image bright-
ness is still too bright to produce an acceptable image on your computer 
screen, you may need to stop-down the aperture of your telescope. 

Look at the 7.	 Live Video Window on the computer screen and adjust the 
focus knob accordingly to determine best image focus. 

Note: The camera’s field of view is fairly small. It is approximately equivalent to 
the field of view through the telescope when looking through a typical (i.e. not 
wide-field) 3.8mm Ultrascopic eyepiece and 2x Barlow.

Image orientation can be changed by rotating the camera within the 8.	
focuser drawtube. Simply loosen the thumbscrew on the drawtube and 
rotate the camera until the desired image orientation is achieved. Retighten 
the thumbscrew on the focuser drawtube when done. You may need to 
slightly refocus (using the telescope’s focus knob) if the focuser drawtube 
has moved a bit inward or outward when the camera was rotated.

Select 9.	 Capture File from the File menu and name your file including the 
AVI extension name. IE mymovie.avi. Click Open. 

Enter the amount of disk space to allocate as a buffer for this data. 10.	
Movie files need a large amount of disk space. Enter a value such as 50 
Megabytes or higher. Press ok. The size of the captured data may be 
much higher than this value depending upon number and size of frames 
captured. 

Select 11.	 Set Frame Rate under the Capture menu. Check the box Use 
Frame Rate and type 15. Press ok.

Select 12.	 Set Time Limit under the Capture menu. Check the box Use 
Time Limit and type 20. Press ok.

Select 13.	 Start Capture under the Capture menu. 

Press ok when you are ready to capture Images. 14.	

An AVI movie sequence of 300 frames (15 frames per second x 20 seconds) 
will now be recorded.

The total number of captured frames is displayed on the bottom bar. If frames 
are being dropped this will be displayed and the frame rate or resolution 
should be set to a lower value to prevent this.

You have now taken your first images with the SSUE! This simple method 
of imaging is exactly how the camera is used to capture terrestrial subjects 
during daylight hours. Close-up images of birds and other wildlife or faraway 
vistas can all be obtained in this way with the SSUE. Solar images can also be 
taken during the day with an optional full-aperture solar filter over the front of 
the telescope. 

Figure 5. Changing resolution via 
options->Video Capture Pin.

Figure 6. Changing exposure via 
options->Video Capture Filter.
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Take some time to use the camera and Orion AmCap software during the 
day to become familiar and comfortable with their basic operation. For best 
results, you can optimize your images with the camera controls. 

Camera Controls 
For best images, you can adjust the camera controls though Orion AmCap to 
fine tune the image. You can see how the camera controls affect an image in 
the Live Video Window. 

From the Options menu choose Video Capture Filter and you can access the 
camera controls under Stream property tab. Here you will find the Brightness, 
Contrast, Gamma, Hue, Saturation (level of color), Sharpness (keep this low 
as it can add noise), and Exposure controls. The Exposure control is a gain 
adjustment that allows additional flexibility in adjusting image brightness. You 
can either manually adjust this by unselecting the Auto box and manually mov-
ing the slider, or have automatic adjustment by leaving the Auto box selected. 
Out Door should be checked for night viewing. Other options such as B/W 
mode, Flip, Mirror and White Balance will aid in tuning the live view however it 
is recommended to only modify exposure and brightness if images are to be 
software processed later. To return the camera controls to their default set-
tings, click the Reset button. 

The other camera controls are available by selecting Video Capture Pin from 
the Options menu. This accesses the Stream Format property sheet, which 
allows you to set additional parameters. The Frame Rate, while generally 
should be left at 15 frames/second for the sharpest planetary images, can be 
toggled down to 7.5 frames/second for brightest exposures. This value may be 
overridden If the use Frame Rate box Is checked in the Capture -> Set Frame 
Rate menu. (You can also use the Video Capture Filter selection described 
previously to adjust image brightness.) The Output Size can be used to change 
the image size if desired; the sharpest images being at the native resolution of 
320x240 and best for saving large movie files and the highest resolution (1280 
x 960) is best for group viewing and as a focus aid. 

Try several different settings to get a feel of how the camera controls work 
and affect the resultant image on the computer screen. The Brightness and 
Exposure controls are the ones you will use the most. The telescope being 
used, seeing conditions, and object being imaged will dictate how these cam-
era controls should be set. Usually Exposure will be set first, then Brightness 
is adjusted as needed. 

Astronomical Imaging
Now that you’re familiar with basic camera and software operation, it’s time 
to take the SSUE out at night under the stars to capture some astronomical 
images. We recommend starting with the Moon, as it is easy to acquire into 

the camera’s field of view, and typically 
does not require stacking of multiple 
exposures as planetary images do. 

Imaging the Moon
Imaging the Moon is much like imaging 
terrestrial objects during the day. Since 
the exposure is very short, it is not criti-
cal that the telescope be precisely polar 
aligned. 

When the moon is past half full, it is 
hard to get detail due to the tremendous 
glare off of the lunar surface. Most detail, 
even on a sliver of a moon, will be at the 
terminator (that tiny thin line between 
the shadow and light, see Figure 7). To 
get more of the moon in the image, a 
focal reducer will need to be used. For 
close-ups of craters use a barlow lens 
(see “Using Focal Reducers and Barlow 
Lenses”). 

Imaging Planets
The best planetary images will be 
obtained by stacking (combining) many 
individual images in order to improve 
image contrast, brightness, and detail. 

A great way to obtain images for stacking is to take several seconds of video 
of the planet, then break the video into individual frames for stacking. Since 
the SSUE has a maximum frame rate of 15 frames per second at maximum 
resolution, you can literally obtain hundreds of images for stacking in seconds! 
You save time by taking one video instead of dozens of individual pictures! 

Since you will be taking multiple images over a period of time, it is important 
you have a decent polar alignment in order to keep the planet within the field of 
view of the camera. To this end, having a motor drive (at least single-axis) will 
also be helpful. Otherwise, you will periodically need to rotate the R.A. slow-
motion knob to keep the planet within the camera’s field. 

Tips 
Focusing 
One of the hardest things to do in planetary imaging is achieving good focus. 
You can make this process easier by simply watching the Live Video window 
to focus. Depending upon the viewing conditions you may notice that the 

Figure 7. The moon’s surface detail 
looks the best along the terminator.

Figure 8. (left) Jupiter live image. 
(right) 500 frames Aligned, stacked 
and enhanced using Registax 
Image Processing Software. Image 
taken with Orion 180mm Mak-Cass 
telescope.
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image goes in and out of focus – this is due to viewing conditions. This is to 
be expected and one of the reasons why post processing software can bring 
out the best in your captured images. Focus as best as possible with the 
average frame being at best focus to ensure more in focus frames than out of 
focus. Image processing software can then be used to select the best frames 
to combine for best results.

Refocus often throughout your imaging session. This ensures at least some 
of your images will have an excellent focus. It is also not uncommon for tele-
scope movements to alter the focus slightly, so be sure to refocus for any new 
astro-imaging targets. 

Choosing a Site for Astro-Imaging 
Once you have a focused image, you may find your image shifting and washed 
out. This can be caused by many environmental factors. Poor seeing (move-
ment of molecules in the air, such as heat rising) and poor transparency (mois-
ture, smoke, or other sky contaminants) will all serve to reduce image quality. 
That is why most major astronomical telescopes are on high mountains in thin 
air, to get above much of the seeing and transparency problems. Also, wind 
will move your telescope and affect images. Your eyes viewing through an 
eyepiece can change slightly to compensate for disturbances like these, but 
the camera cannot. Keep these factors in mind when choosing an observing 
site for astronomical imaging. 

For the best astro-images, we recommend finding a location with dry air, some 
altitude, and away from city or streetlights. Even a nearby hilltop in the coun-
tryside can provide better viewing conditions than many convenient backyard 
locations. 

Loss of Camera Connection 
If the computer connection to the camera is interrupted, you will need to 
re-establish connection. This can happen due to several reasons; if a cable 
becomes unplugged, the computer “freezes”, or the software/hardware other-
wise temporarily loses the data coming from the camera. 

To re-establish camera connection, first close the Orion AmCap program on 
your computer. Then, unplug and re-plug the camera into the computer’s USB 
port. Now, open Orion AmCap, and the Live Video Window should appear 
indicating re-established connection between camera and computer. 

Using Focal Reducers and Barlow Lenses 
Focal reducers serve to decrease the focal length of your telescope. This 
increases the field of view seen by the camera (decreases camera magnifica-
tion). This can be useful for obtaining images of wider objects, such as the full 
Moon or a landscape vista. 

Barlow lenses, or other tele-extenders, increase the focal length of your tele-
scope, which makes the camera field of view narrower (increases camera mag-

nification). This is useful for high-power planetary images. Keep in mind that 
when the focal length is doubled, the image will become four times dimmer, so 
a longer exposure may be necessary. 

For best planetary imaging, you should shoot with an effective focal ratio 
(telescope focal length ÷ telescope aperture) of F/20 or greater. This will give 
you a good combination of image brightness and image scale for planets. For 
most telescopes, a Barlow lens will be required to obtain this focal ratio. For 
example, Schmidt-Cassegrain telescopes usually have a focal ratio of F/10. 
A 2x Barlow lens doubles the effective focal length of the telescope, which 
makes the focal ratio f/20. Similarly, a 3x Barlow lens will yield of focal ratio 
of F/30. You can also try using multiple Barlows to obtain even greater effec-
tive focal ratios. There is a limit to how large a focal ratio your telescope and 
seeing conditions can handle, however. Experimentation will be needed to see 
what your telescope is capable of in the seeing conditions on a given night. If 
the image appears somewhat dim and fuzzy on the computer screen, you may 
want to consider removing the Barlow lens.

(Focal Reducers and Barlow lenses available through Orion, check the catalog 
or www.OrionTelescopes.com for more information).

Filters
For some types of planetary imaging, you may want to use color filters to bring 
out subtle details. Any standard Orion 1.25" filter will thread into the front of the 
SSUE’s barrel. Try using different color filters on a planet to see which filters 
help best show planetary details.

Neutral-density Moon filters and variable-polarizer filters are useful to reduce 
the glare from the moon. They can also be used to reduce the glare from 
Venus.

Solar Filters
Warning: Always use a full aperture solar filter when viewing the sun.

With a properly fitting full-aperture solar filter attached to your telescope, you 
can use the SSUE to take images of the Sun and the sunspots on its surface. 

(Filters available through Orion, check the catalog or OrionTelescopes.com for 
more information).

Flip Mirror
As easy as flipping a switch, the Imaging Flip Mirror enables the astropho-
tographer to find, center and focus a target visually with a 1.25" telescope 
eyepiece, then photograph it with a CCD camera. All without swapping out any 
equipment. It’s a real timer saver, making the normally tedious task of focusing 
with the CCD camera alone easier and quicker. (Available through Orion, check 
the catalog or OrionTelescopes.com for more information).
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USB Extension Cable 
In many instances, it is likely that a lon-
ger cable for the SSUE will be needed 
in order to comfortably setup telescope, 
camera, and computer. We recommend 
purchasing a 10' USB extension cable 
if you need more cord length. (Available 
through Orion, check the catalog or 
OrionTelescopes.com for more informa-
tion).

Things to Do
Moon
Learn your way around our closest 
celestial neighbor. 

Image the craters, mountains and •	
valleys. 

Image the different phases from •	
New moon to Full Moon

Image the detail at the terminator •	

Create a moon mosaic (Figure 9)•	

Planets
Take a movie of the position •	
of the great red spot of Jupiter 
during the Gas Giant’s <10 hour 
day. 

Image Jupiter’s moons and their •	
shadows as they transit across 
the Gas Giant

Follow in Galileo’s footsteps by •	
Imaging the different phases of 
Venus

Solar
Using a full aperture Solar Filter to •	
image sunspots (Figure 10)

Terrestrial
Image animals from a far distance so as not to disturb feeding and •	
nesting spots

  
Recommended Reading
(Books available through Orion, check the catalog or OrionTelescopes.com for 
more information).

Specifications 
Sensor	 Pixart Imaging Inc PAC207BCA Color CMOS sensor

Sensor size	 1/7"	  

Number of pixels	 320 x 240 pixel layout; 0.1 megapixel resolution

Pixel size	 5.6µm x 5.6µm

Video frame rate	 up to 24 frames/second at native resolution 

A/D conversion	 8 bit

IR filter	 Yes 

Connection	 USB 1 or 2 

Barrel	 1.25" threaded for filters

Figure 9. Use software to 
assemble individual frames to create 
a higher resolution image. Image 
taken using Orion Apex 90mm Mak-
Cass telescope and Orion 0.5x 
Focal reducer. 5 Individual images 
assembled In Adobe Photoshop.

Figure 10. Multiple Sunpots. 
Image taken using Orion Apex 90mm 
Mak-Cass telescope. 100 frames 
Processed using RegiStax.



One-Year Limited Warranty
This Orion StarShoot USB Eyepiece is warranted against defects in materials or workmanship 
for a period of one year from the date of purchase. This warranty is for the benefit of the original 
retail purchaser only. During this warranty period Orion Telescopes & Binoculars will repair or 
replace, at Orion’s option, any warranted instrument that proves to be defective, provided it 
is returned postage paid to: Orion Warranty Repair, 89 Hangar Way, Watsonville, CA 95076. 
If the product is not registered, proof of purchase (such as a copy of the original invoice) is 
required.

This warranty does not apply if, in Orion’s judgment, the instrument has been abused, mis-
handled, or modified, nor does it apply to normal wear and tear. This warranty gives you 
specific legal rights, and you may also have other rights, which vary from state to state. For 
further warranty service information, contact: Customer Service Department, Orion Telescopes 
& Binoculars, 89 Hangar Way, Watsonville, CA 95076; (800) 676-1343.

OrionTelescopes.com
89 Hangar Way, Watsonville, CA 95076

Customer Support Help Line (800) 676-1343
© 2010 Orion Telescopes & Binoculars

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) this device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation.

Changes of modifications not expressly approved by the party responsible for compli-
ance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to pro-
vide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an output on a circuit different from that to which the 
receiver in connected.

Consult the dealer or an experienced radio/TV technician for help.

A shielded cable must be used when connecting a peripheral to the serial ports.




